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Welcome

Avenza welcomes you to mapmaking in the 21st century!

Combined with Adobe Illustrator, MAPublisher has revolutionized the art of mapmaking by allowing spatial data
files to be used to create maps inside a vector graphics program. MAPublisher allows all your cartographic tasks to
be performed where they should be done; in a powerful graphics environment.

MAPublisher LabelPro™ revolutionizes the way users can label map data, including using symbols as labels, conflict
resolution, and highly configurable rule-based labeling options. The MAP LabelPro engine uses map data attributes
for labeling with styles, rules and controls configured through an intuitive, easy-to-use Graphical User Interface.

This tutorial assumes that the user is familiar with Adobe lllustrator CS6 and newer and has at least a basic
understanding of MAPublisher tools and features. Not all MAPublisher tools are explained in this document. This
tutorial should be used in conjunction with the MAPublisher 9.6 User Guide, MAPublisher 9.6 Tutorial Guide and
Quick Start Guide for an understanding of all the other MAPublisher tools.

By following this tutorial, you will learn how to setup and use the MAP LabelPro labeling engine to label your

map created in MAPublisher. Working on a provided map, users learn to create rules and styles for labeling in an
automated and efficient way.

MAP LabelPro Tutorial Data

This tutorial will use Adobe lllustrator files and MAP LabelPro rules installed with MAPublisher 9.6. You can find the
MAP LabelPro Tutorial data in the following location on your hard drive:

Windows 7/8
C:\Users\Public\Public Documents\Avenza\MAPublisher 9.6\MAP LabelPro Tutorial & Data\Data

Note: This data may be accessed through shortcuts available in the Windows start menu

Mac0SX
/Applications/Avenza/MAPublisher 9.6/MAPublisher Tutorials/MAP LabelPro Tutorial & Data/Data

You are encouraged to experiment with your own data to gain additional experience with MAPublisher tools.

Tutorial data courtesy of City and County of San Francisco (San Francisco Enterprise GIS program SFGIS).

MAPublisher LabelPro Tutorial | i
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1.1 Purpose

1 Preliminaries

The purpose of this exercise is to use MAP LabelPro to create labels for a simple map of downtown San Francisco,
California, USA. For this exercise, Avenza has prepared the necessary map file created with MAPublisher 9.6 and
Adobe lllustrator, based on City and County of San Francisco GIS data (San Francisco Enterprise GIS program SFGIS).
The map contains all the different type of features (point, line and area) for labeling and obstacle purpose.

In this exercise, you will start by preparing the file and examining the data to familiarize yourself with the
prerequisites to using MAP LabelPro. Then, the labeling will be done in two steps: a main labeling session (labeling
public schools, streets, interstates, highways and land areas in one run) and a secondary session (labeling parks
only, using the other labels as obstacles). Although the presented settings are valid only for the map data they are
based on, the principles are applicable for your own designs.

1.2 Know your data

The MAP LabelPro Tutorial data folder contains a ready-to-use Adobe lllustrator template file containing a map of
downtown San Francisco (MAPLabelPro_Tutorial.ait). Here is a description of the layers present in the file and how
they will be used during the labeling process.

1.2.1 San Francisco map description

Layer name Type Description Labeling Attribute Obstacle?
(label source |ayers) Session #1 | Session #2
Text layers
LAND_labels Text Land labels - - No
SCHOOL_labels Text School labels - - Yes
STREET _labels Text Street labels - - Yes
PARK_labels Text Park labels - - -
HIGHWAY_INTERSTATE_labels | Text Labels for highways and interstates | - - Yes
SUPPRESSED_labels Text Labels that couldn't be placed - - No
based on the specified rules.
MAP_TITLE Text Map title (San Francisco) - Yes No
MAP Layers
Public_Schools_point Point Public school locations SCHOOL_NAME Yes Yes
Post_Offices_point Point Post office locations - Yes Yes
Highways_line Line Highway roads HIGHWAY_NUMBER Yes Yes
Interstates_line Line Interstate roads INTERSTATE_NUMBER | Yes Yes
Ramp_line Line Ramps to highways - No No
Streets_line Line San Francisco street network STREETNAME No No
Land_area Area Land areas AREA_NAME No No
Parks_area Area Park areas PARK_NAME Yes No

MAPublisher LabelPro Tutorial
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Layer name Type Description Labeling Attribute Obstacle?
(label source |ayers) Session #1 | Session #2

Other Layers
Scale_Bar Legend | Scale bar - -
background Area Blue background to represent | - -

the sea

All map layers were imported from City and County of San Francisco GIS data (San Francisco Enterprise GIS program
SFGIS) in ESRI shapefile format and cropped to the area of interest. The map design (symbols and line styles) was
created by Avenza Systems.

1.2.2 Styles and rules

MAPublisher is installed with predefined styles and rules to use for the MAP LabelPro settings in this tutorial. These

configuration files are saved to one of three folders depending on the data type layer, |E5| Area, Line or| «"| Point,
they are associated with.

Layer Name Type Style Rule

\LabelPro\Styles \LabelPro\Rules
Public_Schools_point Point School_Label_Style School_Label_Rule
Interstates_line Line Interstate_Label_Style Interstate_Label_Rule
Highways_line Line Highway_Label_Style Highway_Label_Rule
Streets_line Line Street_Label Style Street_Label Rule
Parks_area Area - -
Land_area Area Land_Label_Style Land_Label_Rule

The style and rules for the Parks_area layer will be created during the second labeling session of this exercise.
The default location of the Rules and Styles folders is:

Windows 7/8: C:\ProgramData\Avenza\MAPublisher 9\LabelPro\Rules
Mac OS X: Applications/Avenza/MAPublisher 9.6/MAPublisher Plug-In/LabelPro/Rules

Note: The MAP LabelPro tutorial data folder also contains a backup for these rules and styles

1.2.3 Important note for MAPublisher LabelPro evaluation users

The evaluation version of MAPublisher LabelPro scrambles the text of placed labels but preserves the case,
spacing and punctuation so that it simulates how actual labels would be placed. Therefore, evaluation users will
experience a different result with the MAP LabelPro settings of this tutorial than licensed users. The results will be
shown and differences explained at the end of this guide. In evaluation mode, the scrambling process noticeably
slows the speed of labeling.

6 MAPublisher LabelPro Tutorial
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2 Getting Started

2.1 Open tutorial document

1. Inthe Adobe Illustrator main menu, choose File> Open and open the template file MAPLabelPro_Tutorial.ait located
in \MAPublisher 9.6\MAP LabelPro Tutorial Guide & Data\Data.

Al e Bt One Tpe Sder St Vew Wesse Hep @ v [———) =lalx]

|| messene ([ T-1N-] e i [o)[— wetem [} mow -]

fepnglosjoniesalavel

An artboard containing a map of San Francisco opens. All the data information to be used for labeling is present,
except for the text labels. Please see the table in the Preliminaries chapter for the description of the layers.

2. Because the file was opened from a template, a new untitled document was created. Choose from the Adobe
lllustrator main menu File > Save As to save the file as San Francisco.ai.

Note: Customize the Adobe lllustrator workspace to make it easier to access panels. It may look different than
the image above. Read Customizing the workspace in the Adobe lllustrator help guide for more information.
Review also MAPublisher Preferences in the MAPublisher 9.6 User Guide.

2.2 Examine MAP Attributes available for labeling

MAP LabelPro extracts label data from the attribute table for each MAP Layer to be labeled. Therefore, it is good
practice and often required to examine or edit attribute information using the MAP Attributes panel. Edits can
include: creating a new column to enter attribute values, joining tables to import additional attribute information
from an external file, correcting spelling, changing the case of text and more.

For this exercise, all attributes are ready to use for labeling. Follow the steps here to examine them and familiarize
yourself with the data.

Note: For more information on the MAP Attributes panel, please refer to the MAPublisher 9.6 User Guide, chapter 5.
For more exercises, please see the MAPublisher Quick Start Guide and MAPublisher Tutorial Guide.

1. Inthe Adobe Illustrator Layers panel, click the target button & next to the Public_Schools_point layer to select
all artwork on the layer.

MAPublisher LabelPro Tutorial 7
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Open the MAP Attributes panel (from the Adobe Illustrator main menu, choose Window > MAPublisher> MAP

Attributes or click the MAP Attributes button on the MAPublisher toolbar []).

The Public_Schools_point layer contains four visible attribute columns: OBJECTID, FACILITY_l, DEPTNAME and
SCHOOL_NAME. The SCHOOL_NAME attribute column will be used for labeling the school points.

MAP Attributes

Layer: | [2] Public_Schools_paint {24 paints selected) ‘ v | . B
[EEloBIECTID [GEIFACILITY_I [3] DEFTNAME [3]SCHOOL_NAME

1 1,913 0000003094 SF Unified School District (SFUSD) | FRANCISCO MIDDLE SCHOOL

2 1,914 0000003095 SF Unified School District (SFUSD) | YICK WOO SCHOOL

3 1,915 | 0000003096 SF Unified School District (SFUSD) | GARFIELD SCHOOL

B 1,919 | 0000003102 SF Unified School District (SFUSD) | JEAN PARKER SCHOOL

5 1,920 0000003104 SF Unified School District (SFUSD) | SPRING VALLEY SCHOOL

6 1,922 | 0000003106 SF Unified School District (SFUSD) | CHINESE EDUCATION CENTER

24 points selected = o IZED

3. Select all artwork on the Interstates_Line layer and view the attributes in the MAP Attributes panel.

MAP Attributes

Layer: | Interstates_line (4 lines selected)

[v] = =2

[£3 STREETNAME

INTERSTATE_NUI

VAN NESS AVE

WAN NESS AVE

LOMBARD 5T

LOMBARD 5T

NS

4lines selected

S 3E

The INTERSTATE_NUMBER attribute column will be used for labeling these roads.

Note: Notice that the INTERSTATE_NUMBER attribute is of type integer [I2]. All types of attributes may be used for

labeling with MAP LabelPro.

Select all on the Highways_line layer and view the attributes in the MAP Attributes panel. HIGHWAY_NUMBER

will be used for labeling. View the attributes of the remaining layers: Streets_line, Parks_area, and Land_area.

Refer to the San Francisco description table in section 1.2.1 to see the attributes that will be used for labeling.

Knowing this information, we are ready to use the MAP LabelPro function to generate map labels for the San

4.

5. Close the MAP Attributes panel after reviewing it.
Francisco downtown map.

8 MAPublisher LabelPro Tutorial
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3 Labeling Session #1

In this first labeling session, multiple layers will be labeled in a single run of MAP LabelPro. The objectives for this
session are to:
- Add labels for school as a first priority (source layer Public_Schools_point).
- Label the interstate roads with interstate shield symbols containing the interstate number (source layer
Interstates_line).
- Label the highway roads with highway shield symbols containing the highway number (source layer
Highways_line).
« Add street names (source layer Streets_line).
«Add names for land areas, written in the sea to make the map more readable (source layer Land_area).
+ Make sure that the school and road names do not overlap with the post office and school symbols and park
area, and do not cross highways and interstates line (obstacle layers: Post_Offices_point, Public_Schools_
point, Parks_area, Interstates_line and Highways_line).

To start the MAP LabelPro Editor, click the MAP LabelPro button on the MAPublisher Toolbar.

Import/Export Properties Data Creation ‘Geoprocessing ‘Organization Thematic Toals Labels Layout Tools
iEIEDﬂ@@ @ MEEIr E 2% 8 E < EeSs B&Y CTCe @ X B0l Fad Eale
MAP LabeIProJ

The MAP LabelPro dialog box opens.

MAP LabelPro
& Setuplayers| [ | Only label selected art Label
Source S é 1
Is cbstade Cancel
Is labeled
Label source: Advanced...
Output layer:
Priarity: 1 B Import Settings...
Style: [Custom] 4 Export Settings...
Click % Setup Layers or Rules: [Custom]

Import Settings to begin
Suppression layer:

Label filters:

All layers have to be configured before labeling with MAP LabelPro. The general MAP LabelPro workflow: setup
layers, specify attribute label source, set label output layer and suppression layers, set label priority, and define layer
styles and rules.

Note: If the dialog box needs to be closed before all settings are done, make sure to click the Save button.

MAPublisher LabelPro Tutorial 9
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3.1 Layers and obstacles setup

1. Inthe MAP LabelPro editor dialog box, click the Setup Layers button.
2. Inthe Setup Layers dialog box, click the check box in the Show column for each of the following layers:

Setup Layers

Mame oK

4 @ san Francisco Downtown ey
« MAP_TITLE HIGHWAY_INTERSTATE labels

. LAND_labels
«  Post_Offices_point MAP. TITLE
«  Public_Schools_point PARK labels
. . SCHOOL _labels

« Highways_line STREET_labels

SURPRESSED_labels

« Interstates_line Post_Offices_point
. . Public_Schools_point
Streets_line Highmays. Inc
. Land area Interstates_line
- Ramp_line
- Parks_area Streets line
background
Land_area

REORORERRIOO000RO0R g

Parks_area

3. Make sure that the settings match the image above and click OK.

The MAP LabelPro dialog box displays the MAP View and chosen layers. Layers can be designated for labeling
and obstacles in the list by clicking the appropriate column.

MAP LabelPro
& Setuplayers| ] Only label selected art Label
“ | Source &t Save
- |4 e San Francisco Downtown Is obstadle Cancel
MAP_TITLE
Post_Offices_point Is labeled
Public_Schaols_p... Label source: - Advanced...
Highways_line
Interstates_line Output layer: -
Streets_line Priority: 1 B Import Settings...
Land_area
Parks_area Style: [Custom] = £ Export Settings...
Rules: [Custom] = 4
Suppression layer: v
Label fiters: T, [ @

10 | MAPublisher LabelPro Tutorial
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4. The first layer in the Source list, MAP_TITLE, will be designated as an obstacle. Click the corresponding spot in

the Obstacle column.

[] Only label selected art

®ét
4 @ san Francisco Downtown
MAP_TITLE &1
Post_Offices_point
Public_Schools_p...
Highways_line
Interstates_line
Streets_line
Land_area
Parks_area

& Setup Layers

Source

MAP_TITLE
Is obstacle
Is labeled
Label source: #Fontramily
Output layer: [Create on label generation]
Priority: 1 B
Style: [Defaul]
Rules: [Defauit]
Suppression layer: | [7] [[anored]

Notice that the Is obstacle check box is also checked, indicating that it is designated as an obstacle. An obstacle
is an object that impedes the placement of a label. See chapter 17 of the MAPublisher User Guide.

5. Now designate the other layers as labeled or an obstacle by clicking the appropriate column:

Labeled
Public_Schools_point
Highways_line
Interstates_line
Streets_line
Land_area

3.2 Labeling extents setup

Obstacle
Post_Offices_point
Public_Schools_point
Highways_line
Interstates_line
Parks_area

@ Setuplayers| [ Only label selected art

Source ® &t Parks_area
4 @ san Francisco Downtown
; Is obstacle
MAP_TITLE & g
Post_Offices_point & [ 1s labeled
Public_Schools_p... g € 1| Label source: LAND_ID
&
T & 1 | Outputlayer: [Create on label generation]
é
| ® 1| priority: 1 B
L ® 1
arks_area & Style: [efault]
Rules: [Default]
Suppression layer: | [7] [ignered]

The configuration described in this exercise will limit the creation of labels to the extent of the selected source

layers for labeling, with a margin of 0.2 inches on each side.

1. Click the Advanced button in the MAP LabelPro dialog box.
2. Under Label Placement Area, choose the Extents of labeled

layers option.

3. Click the Label Margins check box. Set the Top, Left, Right and

Bottom drop-down lists to 0.20in.

Note:

If the option Paths without stroke are not considered obstacles
is checked, areas that have no stroke will not be used as an
obstacle in the labeling process, allowing generated labels
to overlap with them.

Advanced

Label Placement Area:

(®) Extents of the current artboard
- Cancel
() Extents of labeled layers

Label Margins:

Top: 0.20in -
Left: 0.20in —
Right: |0.20in =
Bottom: |0.20in ~
Obstacles:

[] Paths without stroke are not considered obstades

4. Make sure that the settings match the image above and click OK.

The label styles and rules of each source layer are now ready to be set.

MAPublisher LabelPro Tutorial
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3.3 Point layer label settings
1. In the MAP LabelPro editor dialog box, click Public_Schools_point in the Source list to highlight the row.

By default, the attribute to use as a label is set to FACILITY_I, the first string attribute column of the
Public_Schools_point layer. It needs to be changed to SCHOOL_NAME.

Note: Increase the width of an attribute column to see its full name.

2. Click the Label source drop-down list and choose SCHOOL_NAME.
3. Click the Output layer drop-down list and choose SCHOOL_labels.

Source S

4 @ San Francisco Downtown
Is obstacke
MAP_TITLE £

Post_Offices_point

1 Public_Schools_paint

o~

Islabeled

[,

Public_Schools_p... ‘» 1| Label source: 5l SCHOOL_NAME -

Highways line 2N 1

Interstates_line <% ;| Cutputiayer: STREET labels -

Streets_line % 1| Priority: L=

Land_area ® 1

Parks_area é Style: [Default] - [[&
Rules: Default] + 7]
Suppression layer: | [7] [lgnored] -

Leave the Priority column set to 1. The Public_Schools_point layer will be labeled as a first priority while the
others will be set to a secondary priority. Next, you'll change the style and rules for this layer.

4. Click the Style drop-down list and choose School_Label_Style. Click the Edit button 7 to open the Style dialog box
and examine its settings. This style was predefined for the purpose of the tutorial.

Style
Name: School_Label Style =]
Font family: | T Verdana v|| Cancel
Fontstyle: |Bold -
Size: 6.00 pt s
coour: [l
Label case: |Leave asis -
Opacty: 100% =

[ Add halo tolabe!

Colour: ||

Size: | 1.00pt B

Preview:

Show actual size

Note: The second labeling session will show how to create a new style from scratch.

5. After reviewing the point Style settings, click OK to close it.

12 | MAPublisher LabelPro Tutorial
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6. Click the Rules drop-down list and choose School_Label_Rule. Click the Edit button . to open the Point Rules
dialog box and examine its rules in each tab. These rules were predefined for the purpose of the tutorial.

Paint Rules Paint Rudes Point Rules
Mame: School_Labed_fde = o Mame: Schocl_Label Rude =] o Marne: Schood_Label Rude =] o
Placemers | Fittng | Conflel Avoriarcn Cancel Flacomert | Fittng | Confict Avoeiwncn Cancel Pacereet | Fitsg | Confict Avodance cancel
Oewr Loat 5 | 1o/ s encng: Srmicasty| ) Al bt 10 crons chetacies
e Faim Ut ipmdkes -
@ sigrmen: [Featre - )
| qpeie] [ Mo ovetecong sbets
7 ) Ao fant redction: -
City "
oy R = 2 (] Mbow e of leacier Ines:
ol Ench ey st Lt 10 ek the st et by s i
Select el placement in order of prioity; G| bl f ey ¥

unselect
Destons vl nat be used, Label offiset wil natie ¥
et the center piacasent postcn y

[ Sty labed aifact:
Chympis

These point settings will force the labels to be placed below the symbols:

+ When possible, the text will be placed lower-middle to the symbol.

« If this is not possible due to space constrictions, text will be placed to the lower-right, and then to the lower-left.
« If none of the options can be applied, the text will be placed on the suppression layer (or ignored if no

suppression layer was specified).
- Text stacking and font reduction have also been enabled to add flexibility to the placement rules.

Note: More information on the available labeling options can be found in the MAPublisher User Guide, chapter 17.

7. After reviewing the Point Rules dialog box, click OK to close it.
8. Click the Suppression layer drop-down list and choose SUPPRESSED_labels. (It looks gray because its visibility is

toggled off in the Layers panel).

% Setuplayers| [ | Only label selected art Label
e ® & 1| Pubic_Schoos_poit
4
@ San Francisco Downtown . e
MAP_TITLE &
Post_Offices_point é Is labeled
Public_Schools_p.. < 1| Label source: [F3 SCHOOL_NAME - Advanced...
Highways_line ® & 1
nterstates line & 1 |Outputlayer: STREET_labels -
Streets line ® T | Priority: PR Import Settings...
Land_area ® 1
Parks_area é Style: School_Label_Style + 7| 3| |[Exportsettings...
Rules: School_Label_Rule - 7| %
Suppression layer: | [T] SUPPRESSED _labels -
o labl this lyer using multile typss of labels, click T o sdd
a label fiteg or 5 to batch generate lab fiters.
Label filters: | T, [#]

Labels that can not be placed will be copied to the SUPPRESSED_labels layer.

MAPublisher LabelPro Tutorial | 13
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Note: Scroll to the right of the MAP LabelPro dialog box or expand it to see the Suppression Layer column.

This finalizes the configuration for the labeling of the Public_Schools_point layer. Do not close the MAP LabelPro
dialog box as the configuration of the roads and land layers still have to be set. If you want to save the current
configurations, click the Save button. You will have to reopen the MAP LabelPro dialog box to continue.

3.4 Line layers label settings

This section covers the labeling configuration for the source layers Highways_line, Interstates_line and Streets_line.
Highways and interstates will be labeled using highway and interstate symbol shields—notice that these layers
contain double-lines for each road (divided highways).

3.4.1 Label lines with symbols

In the MAP LabelPro dialog box, click the Highways_line layer name in the Source column to highlight the row.
Click the Label source drop-down list and choose HIGHWAY_NUMBER.

Keep the Output layer as the default (HIGHWAY _INTERSTATE_labels).

Set the Priority to 2.

Click the Style drop-down list and choose Highway_Label_Style. Click the Edit button [l to open the Style dialog
box and examine its settings. This style was predefined.

A wWN =

Style
Name: [Custom] =]
Font family: | T Verdana - Cancel
Fontstyle: | Regular -
Size: 10.00 pt
coour: [ ]
Label case: |Leave asis -
Opacity: 100% =
] Add halo to label
Colour: ||
Size:  1.00pt
Label with symbol
Symbol file: | generic_shields.Isf -
Symbol: | @) United States Interstate ~ | Height: |0.25in |3
Preview:
No preview available
Show actual size

In addition to the regular font settings, line labels can also be labeled with symbols. In this case, the Label with
symbol option is enabled. Symbol files (*.Isf) contain a series of symbols. In the example above, the United States
Interstate symbol is selected from the generic_shields.Isf symbol file. The symbol size is set to a height of 0.25
inches. The symbol font color is set to white so it can be legible against the blue symbol.

6. After reviewing the Style settings, click OK to close it.

14 | MAPublisher LabelPro Tutorial
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7. Click the Rules drop-down list and choose Highway_Label_Rule. Click the Edit button [.” to open the Line Rules
dialog box and examine its settings. These rules were predefined.

Lirce Fades.
=] = M ighmey sl e = =
e [y g ——— ; =
Label compenrnd Peahres sa ore et
[y
[ @ i cot haare st ot e
o] s .
g ombrtn st by it b
s Une Fates
o = S o ity Lot ke &
Pecemart | Grmong | Ferg | Canlict Avadance Cancl Facomarn | Grmewg | Pewy | Corcdvosncs Cancl
e [ 7] ke 12 v chutacien
|- Marert ot
A _—
= — . g e

With these settings, the highway labels (and shields) will be placed in the middle of each line length and on the
centerline, with a font reduction (if necessary). The Divided Highways setting recognizes lines that are parallel
and share the same name (as specified by the selected attribute). In such cases, it places only one symbol
instead of two or more. The Allow labels to cross lines option needs to be enabled because double highway

lines are very close in proximity and the labels need to cross the lines. More information on line labeling rules
can be found in the MAPublisher 9.6 User Guide, chapter 17.

Note: Evaluation users will see a different result than a licensed user. Because of the text scrambling, the divided
highways cannot be recognized. Here is an example with the interstates:

Result with license: Result with evaluation:
[T - e

8. After reviewing the Line Rules settings, click OK to close it.
9. Click the Suppression layer drop-down list and choose SUPPRESSED_labels.

MAPublisher LabelPro Tutorial | 15
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The settings for the Highways_line layer are completed. Continue with the settings for the Interstates_line layer.
10. Click the Interstates_line layer name in the Source column to highlight the row.

11. Click the Label source drop-down list and choose INTERSTATE_NUMBER.

12. Keep the destination text layer as the default (HIGHWAY_INTERSTATE_labels).

13. Set the Priority column to 2.
14. Click the Style drop-down list and choose Interstate_Label_Style. Click the Edit button [.” to open the Style dialog

box and examine its settings. This style was predefined.

The United States Route symbol is selected from the generic_
shields.Isf symbol file. The symbol size is set to a height of 0.25

15. After reviewing the Style settings, click OK to close it.

16. Click the Rules drop-down list and choose Interstate_
Label_Rule. Click the Edit button .| to open the Line Rules
dialog box and examine its settings. These rules were

The labeling rules for the interstates are the same as for the
highways. Also, the previous note about text scrambling applies

17. After reviewing the Line Rules settings, click OK to close it.
18. Click the Suppression layer drop-down list and choose

3.4.2 Label lines with text only

1.

w

16

Inthe MAP LabelPro dialog box, click the Streets_line layer name in the
Source column to highlight the row. Keep STREETNAME as the Label
source attribute.

Click the Output layer drop-down list and choose STREET_labels.

Set the Priority column to 2.

Click the Style drop-down list and choose Street_Label_Style. Click the
Edit button |7 to open the Style dialog box and examine its settings.
This style was predefined.

Notice that this time Label with symbol is not checked.

After reviewing the Style settings, click OK to close it.

MAPublisher LabelPro Tutorial

3 Labeling Session #1

Style
Name: [Custom] =]
Font famiy: | 7 Verdana S = inches.
Fontstyle:  Reguiar -
Size: 10.00 pt
coor: [
Label case:  Leave asis -
Opacity: 100% =
[ Add halo to label
coour: [ ] predefined.
Size: 1.00 pt
Label with symbol
Symbol file: | generic_shields.Isf -
Symbol: | United States Route « | Height: |0.25in [3 .
for evaluation users.
Preview:
No preview available
SUPPRESSED _labels.
Show actual size

The label settings for the interstate roads are now complete.
Continue with setting up street labels.

Style

Name: Street_Label_Style =]
Font famiy: | 7 Verdana v || cancel
Fontstyle: | Bold -
Size: 6.00pt
coour: [l
Label case: | Leave asis -
Opacity: 00% 3
[ Add hato to lzbel

colour: ||

Size: | 1.00pt
[] Label with symbol
Symbol file:
Symbol: Height: Auto &
Preview:

Show actual size




6. Click the Rules drop-down list and choose
Street_Label_Rule. Click the Edit button 7| to
open the Line Rules dialog box and examine its
settings. These rules were predefined.

Like highway and interstate labels, street labels
will be placed in the middle of each line length
and on the centerline, with an eventual font |
reduction if necessary. The ability to overhang L —
is enabled here. . —

The street lines in this file are not joined. For
example, each street is made of many line
segments that all share the same STREETNAME | b
attribute. To avoid repeating the name of
connecting lines, the Label joined feature

rule is enabled. MAP LabelPro recognizes that
connecting lines sharing a same name need to
be labeled only once.

Note: Evaluation users will see a different result than a licensed user due to the text scrambling. Names are not
recognized as being the same and labels will be created for each line segment rather than one per street.
Result with license: Result with evaluation:

RIS R
&/
.
%, f

&
& %
V4 t;? " %’%
© s
Py &
@ %‘qﬁ"

a5

7. After reviewing the Line Rules settings, click OK to close it.
8. Click the Suppression layer drop-down list and choose SUPPRESSED_labels.

This completes the label settings for all line layers. Do not close the MAP LabelPro dialog box as the configuration
of the Land_area layer still has to be done. If you want to save the current configurations, click the Save button. You
will have to reopen the MAP LabelPro dialog box to continue.

MAPublisher LabelPro Tutorial | 17
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3.5 Area layer label settings

This section covers the labeling configuration for the source layers Land_area. The goal is to add large labels for the
land areas of the map (downtown area, Treasure and Alcatraz Islands).

1. Inthe MAP LabelPro dialog box, click the Land_area layer name in Style
the Source column to highlight the row. Keep AREA_NAME as the Name: Land.Label St =]
Source label attribute. Font famiy: | 1 ara e
2. Click the Output layer drop-down list and choose LAND_labels. i =
3. Set the Priority column to 2. — W
4. Click the Style drop-down list and choose Land_Label_Style. Click e e s
the Edit button .7/ to open the Style dialog box and examine its s w00
settings. This style was predefined. Dmha‘nﬁaw
Colour:
Note: The sample text is cut off because the font size is set to 70 pt ,,:W o i
and is larger than the preview area.
5. After reviewing the Style settings, click OK to close it. ;a m p Ie te)
6. Click the Rules drop-down list and choose Land_Label_Rule.
Click the Edit button |7 to open the Area Rules dialog box and e

examine its settings. These rules were predefined.

Area Rules
The main requirement for labels created from the Land_area =
. . Marme: Land_Label_Rade = o
layer is that labels are placed in the water area. Therefore, Hosenert | Filing | Confict Avdace e
the Allow outside rule is the only placement option enabled. .
. . . . ek | ] Ak brrizontal ineide
Stacking and font reduction option are also enabled to give
more flexibility to the rule. More information on the available SRR | [ Ao ot rie
area labeling rules can be found in the MAPublisher 9.6 User [ [ r——
Guide, chapter 17. IE”’“”"‘"
Note: Labeling Session #2 will explain the creation of area rules for i"”“"‘f" | 01 st e, g humcors
the Parks_area layer.
7. After reviewing the Area Rules settings, click OK to close it. [ “Area Rules
8. Click the Suppression layer drop-down list and choose I =
SUPPRESSED_IabeIs Plocrment | Filtng | Confict Aundance Canel
» | Ao stadang:
All layers have been now configured for the first labeling session. G| e e -
y g g 4
L -
City o] Ak fonit reduction:
iy Sleos: (4 o
ity |.;r=:ﬂ~::;ﬁ.srm 10 thenk the salactad St by
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3.6 Execute labeling with MAP LabelPro

1. Make sure that all the layers have been configured to match the image below and click the Label button.

MAP LabelPro
« Setuplayers| [ ] Only label selected art Label
T 1]
Pl
0 San Francisco Downtown . [ 15 abstadie Cancel
MAP_TITLE é
Post_Offices_point é Is labeled
Public_Schools_p.. "0 < 1| Label source: [ AREA_NAME = Advanced...
Highways_line Q o 2
Interstates line Gy & 2 |Output layer: LAND_lzbels -
[ Streets line % 2 | priority: 5 = Impart Settings...
Land_area \> 2
Parks_area & Style: Land_Labe + | o7 3 Export Settings...
Rules: Land_Labe v | o7 3
Suppression layer: SUPPRESSED la «
To label this layer using multiple types of labels,
cick W to acd = labal fites or () to batch
generate label fiters,
Label filters: | T, [*]

Note: For evaluation users only. Review the MAPublisher warning message and click OK to close it.

i The Evaluation version of Label Pro scrambles the text of placed labels but preserves the
\‘) case, spacng & punctuation so that the results give a sense of how actual labels would
be placed.

Please also note that Unicode & foreign glyphs are mapped on to standard Latin
characters when the labels are scrambled, but are fully supported in the licensed version

of LabelPro.

2. Wait for the process to end to visualize the results (see next page).

The map layers are labeled. Make the SUPPRESSED_labels layer visible to show labels that couldn't be placed
with the specified rules.

3. Save the file and leave it open to continue on with the second labeling session.

MAPublisher LabelPro Tutorial | 19
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Result with full license:

Note: Evaluation users will observe scrambled labels on the map. The Label joined feature rule does not recognize
similar street names due to the text scrambling and places more labels than necessary. Similarly, highway
and interstate roads are labeled with two shields with different numbers. Licensed versions will not see any
text scrambling.
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4 Labeling Session #2

In this second labeling session, continue with the San Francisco.ai file that you saved. This time, only the parks will
be labeled in a single labeling execution of MAP LabelPro. The objectives are to:
Create a label filter to label small parks and large parks.
Create new area label styles for small and large parks.
Create new area label rules for small and large parks.

To start MAP LabelPro, click the MAP LabelPro button on the MAPublisher Toolbar. The settings from the previous

Make sure that the park labels do not overlap with the other labels and with the post office and school

symbols and do not cross highway and interstate lines.

labeling session are remembered. For the new session, the layer setup has to be changed to match the new
objective of this exercise. However, the label extents remain the same as before.

4.1 Layers and obstacles setup

1. Inthe MAP LabelPro dialog box, click the Setup Layers button to setup which layers are shown.

2. Inthe Setup Layers dialog box, click the top Show check box (level with San Francisco Downtown MAP View).

Click the check box again to uncheck all of the check boxes below. Check only the following layers:

«  HIGHWAY_INTERSTATE_labels

«  SCHOOL_labels

«  STREET_labels

- Post_Offices_point

«  Public_School_point
« Highways_line

« Interstates_line

«  Parks_area

Setup Layers

Name

4 @ San Francisco Downtown
HIGHWAY_INTERSTATE_labels
LAND_labels
MAP_TITLE
PARK labels
SCHOOL _labels
STREET labels
SUPPRESSED_labels

Post_Offices_point

Public_Schools_point
Highways_line
Interstates_line
Ramp_line
Streets_line
background
Land_area

v
Z
H
H

Parks_area

FOO000REEROREOOCRE

oK

Cancel

3. Click OK to return to the MAP LabelPro dialog box.
4. Click the Labeled icon for the Parks_area layer only. Make sure the all remaining layers are set as obstacles:

HIGHWAY _INTERSTATE_labels
SCHOOL_labels
STREET_labels
Post_Offices_point
Public_School_point
Highways_line
Interstates_line

Source D&t Parks_area
4 @ San Francisco Downtown ) [ 1s obstade
HIGHWAY_INTERS... &
SCHOOL _labels & Islabeled
STREET labels < Label source: [73 PARK_NAME

Post_Offices_point -

Public_Schools_p... & Output layer: PARK_labels -
Highways_line y Priority: s
Interstates_line < =
Parks_area % 1 | Style: [Defaul] = |5

Rules: [Defaul] + |7
Suppression layer: | [7] [lgnored] -

5. Make sure that the settings match the image above and click OK.

MAPublisher LabelPro Tutorial
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4.2 Create Label filters

This section covers the labeling configuration for the source layer Parks_area. The goal is to add labels for small parks
and large parks (based on the #Area attribute). This is done by creating Label filters that can isloate and classify data
using expressions. In addition, styles and rules will be created from scratch.

22

In the MAP LabelPro dialog box, click the Parks_area layer name in the Source column to highlight the row.
Below the Source list, click the Batch generate label filters button. |5

In the Batch Label Filter Generator dialog box, click the Attribute drop-down list and choose #Area, then click the
Load button.

In the Data Classification section, click the Method drop-down list and choose Natural Breaks (Jenks-Capsall) and
change the Data classes to 2.

Batch Label Filter Generator

Source: B Parks_erea [ tgnore: 5]
Attribute: | [B #Area -

Empty expression. In position: 0 Cancel

Load

Data Classification:

Source: 44 value(s) (44 unique) from #Area

Method: |Matural Breaks (Jenks-Caspall) + Data dasses: |2 = Indusive boundary: | Startvalue -
Expression Start End

1 2,062.343202373944223 <= #Area < 150,047.372092414647341 2,062.343202373944223  150,047.372092414647341

2 150,047.372092414647341 <= #Area <= 500,626.703131977796555 150,047.372082414647341 500,626.705131977796355

[] Add rule expressions to Recent Expressions in Expression Library Add rule for ignored expression

Two classes (defined by two generated expressions) will define the small and large parks. The Natural Breaks
classification looks for appropriate breaks in the data where to use as data class boundaries. The next step is to
set some default settings for the labels (which sets them for both label filters).

In the Default Settings section, click the Is labeled check box. Click the Label source drop-down list and choose
PARK_NAME. Click the Output layer drop-down list and choose PARK_labels from the drop-down list. Click the
Suppression layer drop-down list and choose SUPPRESSED _labels.

Default Settings:

[ 1s obstace Priority: 1 o

[ 1s Iabeled Style: [Default] - |57
Label source: | [f3] PARK_NAME > | Rule: [Default] - (&7
Output layer: PARK _labels ~ | Suppression layer: SUPPRESSED_labels -

Click the Add button to add the two label filters.

MAPublisher LabelPro Tutorial
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4.3 Create styles and rules

1. Inthe MAP LabelPro dialog box, click the first label filter for the Parks_area layer to highlight it. Change the
name of the first label filter to Small Park. Click the Is labeled check box.

w Setplayers [ Onylobel sdected art Label
Pl p— 5 4 | Meme: Sl Purk Seve
w | 4 @ SanFrancisce Downtown On e
[0 HIGHWAY_INTERS... & i
M SCHOOL labels & [ T Labueledd
[ STREET Labebs & Linbel scuae: il PaRK_NAME d Achvanced. ..
Post_Offices_point & -
Public_chosks,_p. é Cutput byer: [ PARK Jobcks -
[ Highways_line - Bricrty: y = Imprt Setangs...
H Wnerstanes fine &
B Parks_sres Seyle: [Defaur) vlof K ExpertSetngs..
T Senall Park 1
R i -
T samrit« i) -
Suepression layer: | [T) SUPPRESSED, labels -
Lsbel Filter:
) Apcly toad
& Lt by expreamons
Saren 2= 262 HINT AND sarea « 15004 &7 [l

W The expression is vald.
| 5top if art atsfies ths exprassion

Beside the Style drop-down list, click the Edit button . to open the Style dialog box.

Make sure that Arial is selected in the Font family drop-down list and that Regular is selected as the Font style.
In the Size drop-down list, set the font size to 7.00 pt

Click the color chip and in the Color Picker dialog box, pick dark green color (e.g. R=0, G=85, B=0) and click OK.

A

I s |
e |

[ ] Color Swatches

.||||\1a

uhwnN

Calor Picker

Select Color:

O 5 [100%
usm
Comelo | elesw |
.lb.-H 0%
. #[00ss00 | KE

LI Ony Wb Coloss

6. Click the Save button. In the Save Style As dialog box, type Small_Park_Style in the Name box and click Save.

Save Style As

Name: | Smal_Park_Style v

Cancel

7. Inthe Style dialog box, click OK.
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In the MAP LabelPro dialog box, the Style drop-down list now displays Small_Park_Style. The style is saved in the
directory specified in the MAPublisher Preferences.

[ -
Parks_ ® Style: small_Park_Style - &7 % Export Settings...
T Small Park Y 1
Rules: [Default] =
T 150,047.37 <... &
Suppression layer: | [T] SUPPRESSED labels -

Next, you'll create the rules for the Small Park label filter.

8. Beside the Rules drop-down list, click the Edit button | to open the Area Rules dialog box.

9. Inthe Area Rules dialog box, in the Placement tab, click the Allow extending beyond boundary check box.

10. In the Fitting tab, for the Allow stacking rule choose Up to 4 lines from the drop-down.

11. In the Conflict Avoidance tab, In the Click the Allow use of leader lines check box and keep its default parameters.
12. Click the Allow labels to cross lines check box to disable the rule.

Area Rules | Area Rules Area Rules
N fouston] =] o Marrm: [Custom] = o e [custom] =] >
Placoment | Reing | Confict Avoidance Cancel Placement | Fittng | Confict Avoidance ol Placement | Fittng | Corfct voclwce ol
S| ] low labels 0 cross sbstackes
i
Sy SSow demnarr e s, B e
(@i | ) o extending beyend boundary = 7] Al ot redhachons:
g P L
' Chy o (4 [ | 1 o e o ot wnes:
2 Frespaen BT Sk i il e s s o by st Al b ot |3
- | ] Mow nsde., slong boundary Lendes wlth: o0t

Ao sty Ste sl =

13. Click the Save button and in the Save Rule As dialog box, type Small_Park_Rules in the Name box and click Save.

Save Rule As

Mame: | Small_Park_Rules s

Cancel

14. In the Area Rules dialog box, click OK.

In the MAP LabelPro dialog box, the Rules drop-down list now displays Small_Park_Rules. The rule is saved in the
directory specified in the MAPublisher Preferences.

15. Repeat the same process to setup the second label filter as Large Park. Choose a different font style and label
color to help distinguish large parks from small parks.

Hint: Choose the same Style and Rules as Small Park label filter. However, edit the Small_Park_Style to change the
font style and label color, then save it as Large_Park_Style.
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MAP LabelPro

w Setuplayers [ Onlylabel selected art Label
2] [Sowee D & 1| teme: [lrgeran
w | 4 @ San Francisco Downtown ) [ P
HIGHWAY_INTERSTATE labels é
SCHOOL _labels é Islabeled
STREET labels & Label source: 53] PARK_NAME - Advanced...
Post_Offices_point é
Public_Schools_point & Output layer: PARK labels -
Highways _line & " = Import Settings. ..
- Priority: 1 B
Interstates_line &
Parks_area ® Style: Large_Park_Style ~|&7||3 | |Export Settings...
T Small Park ® 1
Rules: Largel Park_Rules - »
T Large Park ® 1 Fa
Suppression layer: SUPPRESSED_|abels -
Label Filter:
) Apply toall
(@) Limit by expression:
#Area >= 150047.372092 AND #Area <= 5006 b) [D
« The expression is valid,
Stop if art satisfies this expression

Labe! fiters: [T [ @ @

4.4 Execute labeling with MAP LabelPro
1. Make sure that all the layers have been configured appropriately and click the Label button.

The parks are labeled appropriately according to the style and rules defined in MAP LabelPro.

2. Click the MAPublisher Log button on the MAPublisher Toolbar.

MAPublisher Log

When Layer Message Clear
b ! ¥ LabelPro lsbeling session

¢ Messages during label generation

_ Deselect All
&9 TOTAL: 44 label(s) were placed
50 minutes ago .+ Document Load Export

Shaw:

Statistics about how many labels were placed (or not placed) on each layer are displayed in the log. Notice that
the first labeling session is also listed.

3. After reviewing the statistics, close the MAPublisher Log dialog box.
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Congratulations, you have completed the MAPublisher 9.6 MAP LabelPro tutorial. For more in-depth information
on MAPublisher tools and features, please take a look at the MAPublisher 9.6 User Guide , MAPublisher 9.6 Tutorial
Guide and Quick Start Guide. These documents are installed with MAPublisher or can be downloaded from
http://www.avenza.com/documentation.
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